A Guide to Resume Writing
What is a resume?
A resume is a written tool summarizing your education, work experience, credentials and accomplishments.

What is the purpose of a resume?
The purpose of a resume is to get an interview. In many cases, your resume is the first document a hiring manager will look at
when they are reviewing your application. Employers spend, on average, less than 10 seconds screening a resume, making it a
true “first impression” of you and why you are qualified for the position.

Do I need to make one?
Yes! Most professional positional positions require applicants to submit a resume and cover letter as part of the application
process. We encourage you to start early and continually update your resume as you continue to obtain new skills and
experiences.

What do I do with the resume?
Once you have created a solid resume, your job is to get it to the right people, which means:
•
•
•
•
•

Give it to employers you meet, even if they are not currently hiring.
Upload it to online job banks. We highly recommend starting with Wisconsin TechConnect, Job Center of Wisconsin
and LinkedIn.
Give it to your references. It will help them talk to others about your qualifications and connect you with potential
employers in their professional network.
Provide your resume to individuals that you ask to write a letter of recommendation.
Bring plenty of copies of your resume along with business cards to career fairs or other professional working
opportunities.
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How-to Write a Resume:
Step-by-Step Guide
1. Figure out what type of resume you need.
There are 4 different types of resumes, all customized to fit you and the job for which you are applying. Based on the
description for each, you will choose one that fits your needs best and continue with that type in min.

Functional Resume
•
•

Focuses on skills and experiences first, employment history second
Works best for individuals who have gaps in employment, limited work experience, or are making a career switch.

Chronological Resume
•
•

Focuses on work history, with the most recent position listed first. This is most preferred by employers.
Works best for individuals with a strong work history, no gaps in employment, and if your experiences align with the
job for which you are applying.

Combination Resume
•
•

Focuses on skills and experience and backing it up with work history.
Works best when you are trying to highlight the skills you have that are relevant.

Nontraditional Resume
•
•

Presented in a visual or online format (e.g. video, LinkedIn, portfolio, website, blog, etc.).
Works best for individuals in creative industries such as graphic design, internet marketing, architecture, etc.

Steps 2-9 can be used for all types of resumes, but order may vary based on the type of resume

2. Get your document ready.
Open a new Microsoft Word document. Ensure you are using a size 10-12 point font, depending on the font style. Stick with
simple font styles such as Arial, Calibri, Verdana or Times New Roman. Also, make sure your resume is within 0.5 – 1.0 inch
margins.
To change this setting, click the Page Layout tab  Margins  Normal (1.0”) (pictured below)
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3. Make a heading that contains all of your contact information.
This section includes your name, telephone number and email address (student or professional account). Optional: Your
address and/or LinkedIn account URL if the profile is complete.
•
•
•

Your name should be the largest font on the document, but should be no bigger than an 18 point font size.
If your resume is more than one page, make sure that your name and/or contact information is on all sequential pages.
You may wish to put your contact information in a header if you are low on space.
Be sure to check the voicemail message on the phone number provided to make sure it is professional and employerready!

To add additional lines in your contact information, on the Home tab, go to the Paragraph settings and click the Borders icon (it
looks like a window), next click the small drop-down arrow to see the selection options. Choose the top or bottom border,
depending on where you want the line.
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4. Write an objective statement. (optional step)
This is often used for individuals making a career switch. Your objective should be 1-2 sentences and help employers
understand what makes you qualified for the position.
If the position you are applying for requires a cover letter, an objective statement is not necessary. The information you share
in your cover letter will serve as your objective statement.
Example:
Customer service focused desktop and administrative technician looking forward to utilizing current education and previous
expertise in new career as a programmer systems analyst.

5. Create a section that highlights your skills.
Listing your skills before education or employment would follow the format of a functional or combination resume type. If
you are following a chronological resume, you may still wish to include this section. Remember to make this section relevant
to the job for which you are applying.
This section could also be called ‘skills from coursework’ if you are listing courses you have taken, or a more specific area of
skill such as ‘customer service’ or ‘social media.’ See functional resume example on page 11 for other section options.
Some industries that prefer or require a skills section include:
•
•
•

Information technology (IT)
Health
Design/Art

•
•

Human services and
Manufacturing

If you are fluent or proficient in a language other than English, include that skill here!
To avoid taking up too much room on your resume, consider using columns. When you are done entering your information in
a bullet list, simply select the list and go to the Layout menu and Columns. In this example we have chosen 2 columns.
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6. List your education.
You should list the following in this section:
•
•
•
•
•
•

The highest degree you earned (bold this on your resume)
The institution where the degree was granted
City and state of that institution
Date of graduation (or expected)
Other certifications or technical diplomas received
Do not include a high school credential if you are in college

Optional: GPA if it is high (we recommend 3.5/4.0 or higher).
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7. Write your experience section.
For each company or position, provide the name, city and state, date of employment, position title, and some key
responsibilities and achievements. If the position has little in common with the position for which are you applying, you may
want to include transferrable skills, or skills you have acquired and will transfer to future employment settings. Examples of
these could be interpersonal, communication or organizational skills.
•
•
•
•
•

If you are following the chronological or combined resume, list your experiences starting with the most recent.
For a promotion within the same company, or if you’ve held multiple titles, list the company once and each position
separately.
Be sure to use action verbs when writing your descriptions (see action verbs on page 9).
For a position you held in the past, use the past tense. For a job or experience you are currently in, use present tense.
Use no less than 2-3 bullet points per experience, and no more than 6-7 (amount of bullets is based on
significance/relevance of the position).

You can divide your experience into specific categories, based on relevance, such as the example below. This is often used if
you have work experience that is unrelated to the position for which you are applying.
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8. Write other sections you wish to include on your resume.
You may want to include some of these optional sections if they are applicable to the job:
•
•
•
•
•
•

Volunteer/community service
Professional affiliations
Computer skills or specific areas of expertise (this could also be included in the skills section)
Accomplishments, honors, or rewards
Certifications
Military Service

One section you should not include on your resume is references, nor should you include, “references upon request.”
Employers will ask for references and it goes without saying that you will provide them.
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9. Wait! Don’t forget to save your resume!
To avoid formatting changes when sending your resume to employers, be sure to save the document as a PDF, unless
instructed otherwise.
To do this, go to File  Save as  type your first name, last name, and ‘Resume’  click the drop down menu for ‘Save as
type’  select ‘PDF’

Action Verb Suggestions
When creating bulleted statements to describe your experience, use action verbs to emphasize your skills and
accomplishments. The verbs will help illustrate how what you have done will transfer to what you can do for the new employer
or organization. All the action verbs can be used in present or past tense.

Adaptable Skills
Adapt

Anticipate

Navigate

Adjust

Improvise

Transform

Amend

Modify

Tailor
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Administrative Skills
Lead

Obtain

Pilot

Decide

Prescribe

Institute

Execute

Expand

Analysis Skills
Conduct

Check

Appraise

Sort

Evaluate

Obtain

Summarize

Interpret

Inventory

Record

Support

Preserve

Observe

Provide

Chart

Maintain

Respond

Track

Design

Develop

Produce

Create

Renovate

Construct

Conceptualize

Cultivate

Spark

Explain

Convey

Propose

Demonstrate

Illustrate

Refer

Introduce

Announce

Clerical Skills

Creative Skills

Communication Skills

Development Skills
Discover

Formulate

Introduce

Complete

Implement

Institute

Launch

Determine
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Financial Skills
Forecast

Quantify

Audit

Project

Maximize

Tabulate

Solve

Calculate

Secure

Advise

Serve

Inspire

Aid

Guide

Assist

Facilitate

Care for

Support

Supervise

Monitor

Appoint

Direct

Implement

Resolve

Propose

Charge

Helping Skills

Management Skills

Marketing Skills
Persuade

Increase

Produce

Fundraise

Market

Sell

Motivate

Recruit

Escalate

Compile

Maintain

Simplify

Coordinate

Arrange

Unify

Schedule

Review

Organization Skills

Research Skills
Investigate

Gather

Analyze

Identify

Sequence

Examine

Process

Measure

Screen
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Teamwork Skills
Collaborate

Relate

Facilitate

Participate

Negotiate

Contribute

Mediate

Listen

Discuss

Assemble

Refinish

Inspect

Repair

Install

Troubleshoot

Remodel

Compute

Technical Skills

Maintain
Please Note: This reference guide was created by Career and Employment Services staff at Madison Area Technical College. It
is intended to be a guide and may not be all-inclusive to meet your specific needs. If preparing these documents for a class, be
sure to follow the directions given by your instructor. For additional assistance or to make an appointment, contact us at
careerandemployment@madisoncollege.edu or (608) 243-4598. You can also stop into room D1624 at the Truax campus.
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This is an example of a chronological resume, specifically for an IT-Help Desk position. The work
experience starts with the most recent position held.

Wolfie Wolfpack
1701 Wright Street, Madison, WI 53704 | 608.243.4598 | WWolfpack@madisoncollege.edu

Education
Madison Area Technical College, Madison, WI
Technical Diploma: IT-Help Desk Support Specialist

May 2017

Technology Experience
Technical Team Member, MITA Wolfpack Techies, Madison, WI
•
•
•
•

Oct. 2015-present

Lead project teams consisting of 5 technicians
Ask question to diagnose technical issues and understand needs of the client
Install, configure, and troubleshoot hardware and software
Identify risks associated with projects and adjust solutions accordingly

Supplemental Experience
Best Buy, Madison, WI
Sales Associate Manager
•
•
•
•

Managed 5-7 sales associates in a given department
Coordinated new associates’ training schedule
Handled and solved difficult case referrals from other sales associates
Collaborated with Best Buy locations in Dane Country regarding inventory and availability

Sales Associate
•
•
•

Oct. 2014-Sept. 2015

April 2013-Oct. 2014

Provided customers with product information to match their needs
Assisted customers with purchases, applying for financing, and explained insurance programs
Maintained merchandising and ensured inventory was accurate

Professional Development
Vice President of Marketing

Sept. 2014-present

Association of Information Technology Professionals, Madison Area Technical College
•
•
•
•

Lead marketing events to promote organization around campus
Assist offer team with brainstorming and planning events and meetings
Volunteer with DaneNet to provide IT support to non-profits in the Madison area
Attend networking events through Accelerate Madison
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This is an example of a functional resume, specifically for a marketing position, where
relevant skills are listed before work history.

DAFFY DUCK
Daffyduck@gmail.com | 300 Alexander Ave, Reedsburg, WI 53959 | 608.243.4598

EDUCATION
Madison Area Technical College, Madison, WI

Expected May 2018

Associates of Applied Science: Marketing
Dean’s List: 2016, 2017 | GPA 3.7/4.0
SPECIALIZED COURSEWORK

•
•
•
•

Social Media Principle
Advanced Social Media Campaigns
Mobile Marketing
Global Marketing

•
•
•
•

Innovative Trends in Marketing
Internet Marketing
Publicity and Promotion Strategies
Sales Management

STUDENT LEADERSHIP

•
•

Madison College Volunteer Center, Alternative Break Coordinator
Madison College Marketing Club, Vice-President

08/2016-present
08/2016-present

MARKETING

•
•

Created a marketing portfolio for a local company in Dane County which included both social media and
public promotion advertisements
Observed collaborative meetings between the marketing and sales teams at Land’s End

CUSTOMER SERVICE
•
•

Communicate with clients to answer questions and help locate products
Average a rating of 4.5/5 on a customer satisfaction survey

SOCIAL MEDIA
•
•

Create and maintain content for Madison College Volunteer center Facebook and Twitter
Design Facebook events to market Madison College Volunteer Center

TEAM WORK
•
•

Serve on Madison College Volunteer Center Programming Board
Work with land’s End team members to present satisfaction survey results to management
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EMPLOYMENT HISTORY
Land’s End, Customer Service Representative
•
•

06/2016-present

Greet and provide pleasant shopping experience to patrons
Assist customers with purchase or return of merchandise

COMMUNITY SERVICE
Safe Haven After School Program, Volunteer
•

03/2013-09/2017

Tutored middle school students three days a week on math homework
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This an example of a combination resume. The work history is chronological, but it also
lists key skills for a Vet Tech position.

PINK PANTHER
panther@madisoncollege.edu
1701 Wright Street, Madison, WI 53704 | 608-243-4598 | LinkedIn.com/pinkpanther
Key Skills
•
•
•
•
•
•

Understanding of veterinary medical terminology
Knowledge in animal diseases and pharmacology
Trained in automated laboratory procedures for hematology and clinical chemistries
Strong observation skills used to perceive and interpret signs of fear, aggression,
and other potentially dangerous behaviors exhibited by various animal species
Follow Animal Welfare Act and other regulations pertaining to the care of laboratory
animals
Perform laboratory procedures, including blood chemistries, parasitology and urine
analysis

Education
Madison Area Technical College, Madison, WI
Associates in Applied Science: Veterinary Technician Program

Expected May 2018

Veterinary Technician Experience
Animal Caretaker, Pete’s Farm, Verona, WI
•
•
•
•

Provide nursing care and healing therapy for a variety of animals
Check animal health, room temperature and humidity daily
Maintain clean, sterile, and safe treatment room
Educate and advise clients on animal nutrition and home care

Pet Admission Staff, Pet Resort, De Forest, WI
•
•
•

January 2015-present

May 2012-June 2014

Scheduled the boarding of pets
Checked immunization records prior to admission to the resort
Greeted customers and their pets in a friendly and welcoming manner

Community Service
Volunteer, Humane Society, Madison, WI
•
•

June 2014-present

Provide physical comfort to dogs and cats in need
Groom and bathe animals as needed
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•

Clean and disinfect animal rooms and cages

Volunteer, Hickory Hills Kennels, Madison, WI
•
•

August 2013-June 2014

Assisted in the placement of dogs and cats in boarding facilities
Supervised and ensured safety of 12-20 dogs in doggy daycare

Accomplishments
Madison Area Technical College, Madison, WI
Karen Roberts Outstanding Student of the Year Recipient

December 2016
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This is an example of a combination resume. It is both chronological in experience, but lists the
functional skills necessary for a graphic design position.
This resume was also created within a table.

DAISY DUCK

Madison, WI 53704 | (608) 243-4598 | www.daisyduckdesign.com

Resume Sections

Functional Skills and chronological experience

QUALIFICATIONS PROFILE

Highly creative and multitalented Graphic Designer with experience in
multimedia marketing and print design.

PRINT
•
•
•
•

EDUCATION

Brochures
Logos
Posters
Stationary

PHOTOGRAPHY

WEB/MULTIMEDIA

• Lithography
• Retouching
• Photograph
Restoration

• Web Site Design
• Video Editing
• CD Cover Design

Madison Area Technical College | Madison, WI | May 2016
Associate Degree in Applied Arts in Graphic Design

PROFESSIONAL EXPERIENCE

Mad-Designs | Madison, WI | August 2010-present
Graphic Design Assistant
• Develop and implement solutions to problems encountered in all
phases of the graphic design process
• Apply typographic skills and knowledge to create effective visual
communication
• Manage time effectively and meet deadlines
Wolfpack Websites | Verona, WI | May 2008-June 2010
Design Intern
• Collaborated with team members on graphic design projects
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Resume Sections

Functional Skills and chronological experience
• Learned about the variety of technologies used to create, capture
and manipulate design elements
• Communicated clearly and professionally in both verbal and written
formats

PROFESSIONAL AFFILIATIONS

American Institute of Graphic Arts (AIGA) | Madison College
2012-present

ADDITIONAL SKILLS

•
•

Expert in Microsoft Suite and Adobe Illustrator
Bilingual in English and Spanish
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This is an example of a combination resume for the healthcare field. The experience is chronological
but also includes functional skills relevant to a nursing position.

WOLFIE WOLFPACK, RN
1701 Wright Street, Madison, WI 53704 | C: (608) 243-4598 | wolfpack@madisoncollege.edu

Professional Summary
Compassionate Intensive Care Registered Nurse with experience in large and small hospital
environments. Proficient in handling emergency situations and working cooperatively with clinical staff.

Licenses
Registered Nurse, State of Wisconsin

2016-present

Certified Nursing Assistant, State of Wisconsin

2014-2016

ACLS and BLS Certification

2015

Skill Highlights
•
•
•
•
•

Life support
IV administration
Medication
Therapy and treatment
HIPPA Compliance

•
•
•
•
•

Reporting and documentation
Computer charting
Diagnostic assessments
Vitals
Procedural assistance

Education and Training
Madison Area Technical College

Madison, WI

Associate in Applied Science: Nursing

May 2016

Professional Experience
Intensive Care Registered Nurse

10/2016 to Current

Verona Health Systems

Verona, WI

•
•
•

Give compassionate care to critical patients suffering from injuries or debilitating conditions
Assess patient conditions and administer medications
Observe behavior and symptoms and report changes to on-call physicians

Certified Nursing Assistant

05/2015 to 10/2016
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UW-Hospitals
•
•
•

Provided patients personal hygiene and activities of daily living
Maintained patient stability by checking vital signs and weight, testing urine, and recording
intake and output information
Served and protected the hospital community by adhering to professional standards, hospital
policies and procedures, federal state, and local requirements

Certified Nursing Assistant
Barrett Nursing Home
•
•
•

Madison, WI

01/2014 to 03/2015
Baraboo, WI

Worked with staff to collaboratively manage and assist intensive care wing of nursing home
Monitored behaviors and symptoms and reported changes to nurses
Learned new ways to effectively assist individuals in intensive care from clinical staff
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